
Mac OS X Server
iChat Server Administration

Version 10.6 Snow Leopard



Apple Inc. K
© 2009 Apple Inc. All rights reserved.

The owner or authorized user of a valid copy of 

Mac OS X Server software might reproduce this 

publication for the purpose of learning to use such 

software. No part of this publication might be 

reproduced or transmitted for commercial purposes, 

such as selling copies of this publication or for providing 

paid-for support services.

Every e昀昀ort has been made to guarantee that the 
information in this manual is correct. Apple Inc. is not 

responsible for printing or clerical errors.

Apple

1 In昀椀nite Loop
Cupertino, CA 95014

www.apple.com

The Apple logo is a trademark of Apple Inc., registered 

in the U.S. and other countries. Use of the “keyboard” 

Apple logo (Option–Shift–K) for commercial purposes 

without the prior written consent of Apple might 

constitute trademark infringement and unfair 

competition in violation of federal and state laws.

Apple, the Apple logo, ColorSync, Final Cut Pro, Mac, 

Macintosh, Mac OS, QuickTime, Xgrid, and Xserve are 

trademarks of Apple Inc., registered in the U.S. and other 

countries. Finder and Safari are trademarks of Apple Inc.

UNIX is a registered trademark of The Open Group.

Other company and product names mentioned herein 

are trademarks of their respective companies. Mention 

of third-party products is for informational purposes 

only and constitutes neither an endorsement nor a 

recommendation. Apple assumes no responsibility with 

regard to the performance or use of these products.

019-1416/2009-08-01

http://www.apple.com


5 Preface㨀̀  About This Guide
5 What’s in This Guide

6 Using Onscreen Help

6 Documentation Map

8 Viewing PDF Guides Onscreen

8 Printing PDF Guides

9 Getting Documentation Updates

9 Getting Additional Information

10 Chapter 1㨀̀  Understanding the iChat Service
10 How iChat Works

11 How iChat Users Are Authenticated

12 Using iChat in Small to Medium Organizations

13 Using iChat in Large Organizations

13 Tools for Managing iChat

13 Server Admin

14 Workgroup Manager

14 Command-Line Tools

15 Chapter 2㨀̀  Setting Up and Managing the iChat Service
15 Understanding iChat Screen Names

15 Adding an Account to iChat

15 Using Other Chat Applications

16 Setup Overview

16 Con昀椀guring and Starting Open Directory
17 Opening Firewall Ports for the iChat Service

18 Turning the iChat Service On

18 Setting Up iChat

18 Con昀椀guring iChat General Settings

20 Con昀椀guring Logging Settings

21 Starting iChat

21 Managing iChat

21 Checking iChat Status

  3

Contents



 4  Contents

22 Setting Access Control for iChat

22 Setting iChat SACL Permissions for Users and Groups

23 Setting SACL Permissions for Administrators

23 Using SSL for iChat

24 Locating iChat Con昀椀guration Files

24 Viewing iChat Logs

25 Turning Auto-Buddy Support On

25 Stopping iChat

26 Supporting iChat Clients

26 Chatting with Jabber Buddies

26 Specifying User Name and Password

26 Using a Jabber ID with iChat

27 Chapter 3:  Setting Up Advanced iChat Server Con昀椀gurations
27 Linking Multiple Chat Servers (S2S)

27 Setting Up Server-to-Server Communication

28 Securing Server-to-Server Connections

29 Using Certi昀椀cates to Secure Server-to-Server Communication

30 Creating an Approved Federation Domain List

30 Integrating with Directory Services

30 Setting the iChat Authentication Method

31 Setting Up iChat on Virtually Hosted Domains

32 Index



  5

This guide provides instructions for setting up, con昀椀guring, 
and administering the iChat service on Mac OS X Server.

You will 昀椀nd information about setting up, managing, and monitoring the iChat  
server, Apple’s instant messaging service that promotes real-time communication  

and information-sharing between diverse user groups.

What’s in This Guide
This guide includes the following sections:

Chapter  Â 1, “Understanding the iChat Service,” highlights key concepts and 

provides basic information about iChat messaging in action, iChat messaging in 

organizations, and overviews of the iChat Server.

Chapter  Â 2, “Setting Up and Managing the iChat Service,” describes how to  

set up your iChat server for the 昀椀rst time and how to manage iChat settings  
and components.

Chapter  Â 3, “Setting Up Advanced iChat Server Con昀椀gurations,” provides advanced 

instructions for setting up iChat server connections and con昀椀gurations.

Note:  Because Apple periodically releases new versions and updates to its software, 

images shown in this book may be di昀昀erent from what you see on your screen.

P
re

fa
ceAbout This Guide
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Using Onscreen Help
You can get task instructions onscreen in Help Viewer while you’re managing 

Mac OS X Server. You can view help on a server, or on an administrator computer.  

(An administrator computer is a Mac OS X computer with Mac OS X Server 

administrator software installed on it.)

To get the most recent onscreen help for Mac OS X Server㨀̀

Open Server Admin or Workgroup Manager and then: m

Use the Help menu to search for a task you want to perform. Â

Choose Help > Server Admin Help or Help > Workgroup Manager Help to browse  Â

and search the help topics.

The onscreen help contains instructions taken from Advanced Server Administration 

and other administration guides.

To see the most recent server help topics㨀̀

Make sure the server or administrator computer is connected to the Internet while  m
you’re getting help.

Help Viewer automatically retrieves and caches the most recent server help topics 

from the Internet. When not connected to the Internet, Help Viewer displays cached 

help topics.

Documentation Map
Mac OS X Server has a suite of guides that cover management of individual services. 

Each service may depend on other services for maximum utility. The documentation 

map below shows some related guides that you may need in order to fully con昀椀gure 
iChat Server to your speci昀椀cations. You can get these guides in PDF format from the 
Mac OS X Server Resources website at www.apple.com/server/macosx/resources/.

http://www.apple.com/server/macosx/resources/
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Workgroup
Manager Help

Provides onscreen
instructions and answers

when you’re using
Workgroup Manager

to set up iChat service
for users.

User Management

Describes using
Workgroup Manager

to give users an
iChat service account

and add users to
directory services.

Open Directory
Administration

Explains how to set up
Open Directory to

authenticate users of
iChat service.

Server Admin Help

Provides onscreen
instructions and answers

when you’re using
Server Admin to set up

iChat service.

Advanced Server
Administration

Describes using Server Admin
to install, con昀椀gure, and

administer server software
and services. Includes best

practices and advice for system
planning, security, backing up,

and monitoring.

Getting Started

Covers basic
installation, setup,

and management of
iChat service using
Server Preferences.

Server
Preferences Help

Provides onscreen
instructions and answers
when you’re using Server
Preferences to manage

iChat service.
Information

Technologies
Dictionary

Provides onscreen
de昀椀nitions of server

and iChat service
terminology.

iChat Server
Administration

Describes advanced
options for setting up,

con昀椀guring, and managing
iChat service.

Introduction to
Command-Line
Administration

Explains how to use
UNIX shell commands to
con昀椀gure and manage

servers and services.

Network Services
Administration

Explains how to
set up DNS, VPN,

and 昀椀rewall for use
with iChat service.
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Viewing PDF Guides Onscreen
While reading the PDF version of a guide onscreen:

Show bookmarks to see the guide’s outline, and click a bookmark to jump to the  Â

corresponding section.

Search for a word or phrase to see a list of places where it appears in the guide.   Â

Click a listed place to see the page where it occurs.

Click a cross-reference to jump to the referenced section. Click a web link to visit the  Â

website in your browser.

Printing PDF Guides
If you want to print a guide, you can take these steps to save paper and ink:

Save ink or toner by not printing the cover page. Â

Save color ink on a color printer by looking in the panes of the Print dialog for an  Â

option to print in grays or black and white.

Reduce the bulk of the printed document and save paper by printing more than  Â

one page per sheet of paper. In the Print dialog, change Scale to 115% (155% 

for Getting Started). Then choose Layout from the untitled pop-up menu. If your 

printer supports two-sided (duplex) printing, select one of the Two-Sided options. 

Otherwise, choose 2 from the Pages per Sheet pop-up menu, and optionally choose 

Single Hairline from the Border menu. (If you’re using Mac OS X v10.4 or earlier,  

the Scale setting is in the Page Setup dialog and the Layout settings are in the  

Print dialog.)

You may want to enlarge the printed pages even if you don’t print double sided, 

because the PDF page size is smaller than standard printer paper. In the Print dialog 

or Page Setup dialog, try changing Scale to 115% (155% for Getting Started, which has 

CD-size pages).
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Getting Documentation Updates
Periodically, Apple posts revised help pages and new editions of guides. Some revised 

help pages update the latest editions of the guides.

To view new onscreen help topics for a server application, make sure your server   Â

or administrator computer is connected to the Internet and click “Latest help topics” 

or “Staying current” in the main help page for the application.

To download the latest guides in PDF format, go to the Mac OS X Server Resources  Â

website at www.apple.com/server/macosx/resources/.

An RSS feed listing the latest updates to Mac OS X Server documentation and  Â

onscreen help is available. To view the feed, use an RSS reader application such as 

Safari or Mail and go to: 

feed://helposx.apple.com/rss/snowleopard/serverdocupdates.xml

Getting Additional Information
For more information, consult these resources:

 Â Read Me documents—get important updates and special information. Look for them 

on the server discs.

 Â Mac OS X Server website (www.apple.com/server/macosx/)—enter the gateway to 

extensive product and technology information.

 Â Mac OS X Server Support website (www.apple.com/support/macosxserver/)—access 

hundreds of articles from Apple’s support organization.

 Â Apple Discussions website (discussions.apple.com/)—share questions, knowledge, 

and advice with other administrators.

 Â Apple Mailing Lists website (www.lists.apple.com/)—subscribe to mailing lists so you 

can communicate with other administrators using email.

 Â Apple Training and Certi昀椀cation website (www.apple.com/training/)—hone 

your server administration skills with instructor-led or self-paced training, and 

di昀昀erentiate yourself with certi昀椀cation.

 Â Jabber Software Foundation website (www.jabber.org)—provides information about 

the open source project that uses the Jabber/XMPP protocol, a protocol supported 

by iChat. “Jabber” is a trademarked term given to the XMPP protocol by the Jabber 

Software Foundation.

 Â Jabberd2 Installation and Administration Guide (http://jabberd2.xiaoka.com/)—

provides jabberd documentation. Jabberd is the software that Apple uses for 

implementing the Jabber protocol.

http://www.apple.com/server/macosx/resources/
feed://helposx.apple.com/rss/snowleopard/serverdocupdates.xml
http://www.apple.com/server/macosx/
http://www.apple.com/support/macosxserver/
http://discussions.apple.com/
http://www.lists.apple.com/
http://www.apple.com/training/
http://www.jabber.org
http://jabberd2.xiaoka.com/
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Use this chapter to learn what the iChat service is and how it 
works.

iChat permits users to collaborate by chatting and sharing information using instant 

messaging and data transfer. This real-time interaction between computer users 

promotes collaboration without the delay of mail responses and blog postings or the 

expense of telephone communication or face-to-face meetings.

This collaboration might include:

Brainstorming solutions, making plans, reporting progress, and exchanging   Â

design images

Exchanging weblinks and 昀椀les for use as real-time references, or for follow-up viewing Â

Generating iChat transcripts when you want a written record of interactions   Â

without taking notes

Conducting weekly sta昀昀 or project meetings, which can also facilitate collaboration  Â

among geographically-dispersed team members

Using built-in computer microphones for audio chat Â

Using video cameras for videoconferencing—a direct, personal, and engaging   Â

form of collaboration

How iChat Works
iChat provides secure person-to-person instant messaging and chat-room services 

using standard Extensible Messaging and Presence Protocol (XMPP), which is found in 

many instant-messaging servers such as Google Talk, Wild昀椀re, and Jabber.

The core of the iChat server is open source Jabber v2.1, which provides user-presence 

information (status, icons, and so on) and basic text-message exchange between users 

or groups (via chat rooms). iChat chat-room features are provided transparently by the 

Jabber multiuser (MU) conference module.

1Understanding the iChat Service
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Apple uses the jabberd software, which implements the Jabber protocol. Jabber is a 

trademarked term given to XMPP by the Jabber Software Foundation.

iChat provides peer-昀椀le transfer between users that can’t establish direct connections to 
a network because of intervening 昀椀rewalls that block such connections. In the case of 
昀椀rewalls, the iChat server acts as a 昀椀le-transfer proxy, using the Jabber Proxy65 module.

To access messaging and 昀椀le transfer services, users connect to the iChat server from 
various compatible instant messaging (IM) applications. When connected, users can 

receive information about the status of other subscribed users, exchange messages 

with users or groups (via chat rooms), or exchange 昀椀les with users.

Additionally, users can send messages to o昀툀ine users. These messages are held by the 
iChat server and delivered when o昀툀ine users connect to the server.

The iChat server also federates, or unites with, other iChat servers or any XMPP-

compliant service (such as Google Talk) using the server-to-server (S2S) capabilities 

of XMPP. This allows users with accounts on iChat servers to exchange text messages 

or 昀椀les with users whose accounts are maintained outside their local network 
infrastructure, as long as those servers are accessible via the Internet.

To communicate with outside servers, the iChat server uses a program called S2S, 

part of the suite of programs that comprise the Jabber v2.1 server, to establish mutual 

connections with them.

The iChat server can be con昀椀gured to require that S2S sessions be encrypted and to 
block S2S sessions with servers that do not support encryption. For encrypted sessions 

to be established, both servers must possess public key certi昀椀cates, either self-signed 
or issued by a recognized Certi昀椀cate Authority (CA).

Mac OS X Server includes a preinstalled, default, self-signed certi昀椀cate, and accepts 
self-signed certi昀椀cates from other servers. Depending on the XMPP software vendor at 
the other end of the S2S connection, a certi昀椀cate from a trusted authority might need 
to be installed on the server before S2S sessions can be established.

For more information about increasing server security, see Mac OS X Server Security 

Con昀椀guration Guide. Certi昀椀cate information can also be found in Advanced Server 

Administration.

How iChat Users Are Authenticated
To use iChat on a speci昀椀c server, users must be de昀椀ned in directories that the server 
uses to authenticate users. In addition, iChat uses Secure Socket Layer (SSL) to protect 

the privacy of users while they chat. 



The following describes the process of iChat user authentication:

Step 1㨀̀ Initiating a Chat

To start a chat with another user, you must 昀椀rst know the user’s short name and the 
domain name that the iChat server is con昀椀gured to use.

Step 2㨀̀ Verifying Identity

iChat veri昀椀es the identity of users by using Open Directory authentication. Users 
are authenticated only if they’re de昀椀ned in a directory domain in the server’s Open 
Directory search path.

Step 3㨀̀ Authorizing the User

iChat makes sure that users are authorized to use the service. The server administrator 

can optionally deny access to speci昀椀c users.

Step 4㨀̀ Processing URLs

Users can send 昀椀les and URLs back and forth, making it easy to jointly review 
information. Because URLs are text, they are passed as normal messages by 

themselves, or in the body of larger text messages.

URLs are unique in that they are recognized and handled di昀昀erently when displayed 
in the chat window. Conversely, 昀椀les are not text and are handled through a di昀昀erent 
exchange that requires the receiving user to approve the 昀椀le transfer before it can occur.

Step 5㨀̀ Recording a Chat

An iChat client can be con昀椀gured to record its own chat transcripts. The iChat server 
can also be con昀椀gured to record all chat messages. The client recording capability 
is useful to the individual iChat user, while the server message logging capability is 

intended for administrative and auditing purposes.

Using iChat in Small to Medium Organizations
For instant messaging in small to medium organizations, you can choose the standard 

con昀椀guration of Mac OS X Server during the installation process. When using a 
standard con昀椀guration, you should use Server Preferences to administer iChat, which 
permits quick and easy con昀椀guration.

When using the standard con昀椀guration, iChat supports an auto-buddy feature.  
The auto-buddy feature adds or deletes users to your iChat buddy list when they are 

added or deleted in Server Preferences. For more information, see “Documentation 

Map” on page 6.

For more information about setting up an iChat server in a standard con昀椀guration,  
see Getting Started.
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Using iChat in Large Organizations
You can con昀椀gure and manage the iChat server using Server Admin in the advanced 
con昀椀guration of Mac OS X Server v10.6. For more information, see Chapter 2, “Setting 

Up and Managing the iChat Service.”

You can also use Server Admin to create customized iChat con昀椀gurations depending 
on your organization requirements. For more details, see Chapter 3, “Setting Up 

Advanced iChat Server Con昀椀gurations.”

This includes setting up a server-to-server federation. When the server-to-server 

federation is enabled, communication with most other XMPP-compliant chat servers  

is also established, including the ability to federate with Google Talk.

For servers on di昀昀erent networks to communicate, administrators must con昀椀gure 
domain name server (DNS), network address translation (NAT), and 昀椀rewalls, as 
needed. To use Server Admin for an advanced con昀椀guration of iChat, see “Setting Up 

Server-to-Server Communication” on page 27.

Server Admin o昀昀ers additional options for securing server-to-server communication. 
This includes using certi昀椀cates and 昀椀ltering who has access to the iChat server. For 
more information, see “Securing Server-to-Server Connections” on page 28.

Tools for Managing iChat
Server Admin and Server Preferences provide a graphical interface for managing iChat 

in Mac OS X Server. In addition, you can manage iChat from Workgroup Manager and 

from the command line using Terminal.

These applications are included with Mac OS X Server and can be installed on other 

computers with Mac OS X v10.6 or later, making those computers administrator 

computers. For more information about setting up an administrator computer, see the 

server administration chapter of Getting Started.

Server Admin
Server Admin provides tools to help you set up, manage, and monitor iChat and other 

services. Use Server Admin to:

Set up Mac OS X Server as an iChat server. For instructions, see “ Â Setting Up iChat”  

on page 18.

Manage and monitor the iChat server. For instructions, see “ Â What’s in This Guide”  

on page 5.



For more information about using Server Admin, see Advanced Server Administration. 

This includes information such as:

Opening and authenticating in Server Admin Â

Working with speci昀椀c servers Â

Administering services Â

Using SSL for remote server administration Â

Customizing the Server Admin environment Â

Server Admin is installed in the /Applications/Server/ folder.

Workgroup Manager
Workgroup Manager provides comprehensive management of Mac OS X Server  

clients and users.

For basic information about using Workgroup Manager, see User Management.  

This includes information such as:

Opening and authenticating in Workgroup Manager Â

Administering accounts Â

Customizing the Workgroup Manager environment Â

Workgroup Manager is installed in the /Applications/Server/ folder.

Command-Line Tools
Command-line tools are available for administrators who prefer using command-line 

server administration. For remote server management, submit commands in a secure 

shell (SSH) session. You can enter commands on Mac OS X servers and computers 

using the Terminal application, located in the /Applications/Utilities/ folder.

For more information about command-line tools, see Introduction to Command-Line 

Administration.
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Use this chapter to set up and manage iChat in Mac OS X 
Server.

This chapter helps you perform the initial iChat server setup and provides information 

about using, managing, and administering iChat.

Understanding iChat Screen Names
iChat screen names are Jabber IDs and use the general format user-short-name@

iChat-domain-name (for example, nancy@ichat.example.com). The user-short-name 

component is the short name of a user de昀椀ned in the Open Directory search path of 
the iChat server. The iChat-domain-name component identi昀椀es the iChat server.

To use iChat, you must have a Jabber ID and you must know the Jabber IDs of 

everyone you want to chat with. Your Jabber ID is created when your user account is 

created in Open Directory.

Adding an Account to iChat
When you 昀椀rst run iChat and enter the initial setup information, you can use the 
iChat > Preferences pane to create your account. 

After you add your account information you can then add other users to your buddy 

list. Because buddy lists are saved on the server, they’re always available when you 

start iChat.

For information, see “Supporting iChat Clients” on page 26.

Using Other Chat Applications
You can use other instant messaging applications with iChat as long as the application 

supports the Jabber protocol. iChat supports instant messaging applications on 

Windows, Linux, and popular personal digital assistants (PDAs).

2Setting Up and Managing the 
iChat Service



Setup Overview
Here is an overview of the steps for setting up iChat service:

Step 1: Con昀椀gure and Start Open Directory
iChat uses Open Directory to authenticate users and must be con昀椀gured before 
setting up iChat. See “Printing PDF Guides” on page 8.

Step 2㨀̀ (Optional) Set Up the Firewall Service

If you are using a 昀椀rewall, iChat requires speci昀椀c ports to be open for iChat features to 
function. See “Getting Documentation Updates” on page 9.

For more information about Firewall service, see Network Services Administration.

Step 3㨀̀ Turn the iChat Service on

Before you con昀椀gure iChat, turn it on. See “Getting Additional Information” on page 9.

Step 4: Con昀椀gure iChat General settings
Con昀椀gure the General settings to add host domains, select an SSL certi昀椀cate,  
choose your authentication method, and enable XMPP server-to-server federation.  

See “Con昀椀guring iChat General Settings” on page 18.

Step 5: Con昀椀gure iChat Logging settings
Use Logging settings to specify where to archive the iChat message logs.  

See “Con昀椀guring Logging Settings” on page 20.

Step 6㨀̀ Start iChat

Start iChat on the server using Server Admin. See “Starting iChat” on page 21.

Con昀椀guring and Starting Open Directory
iChat uses Open Directory to authenticate users and service access control lists 

(SACLs) to verify that users are authorized to use iChat. For more information about 

con昀椀guring Open Directory, see Open Directory Administration.

Before you can use iChat:

You must be de昀椀ned in the Open Directory search path of that server Â

You must be authorized to use iChat service on that server Â

After you log in to iChat, you can chat with any other users who have access to  

the same iChat server or who are reachable using server-to-server federation, if it  

is enabled.

For more information about search paths and iChat service authentication,  

see “Setting Access Control for iChat” on page 22.
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Opening Firewall Ports for the iChat Service
iChat requires speci昀椀c ports to be open on your server. If you have a 昀椀rewall 
con昀椀gured or you are using the Mac OS X Server 昀椀rewall, you must enable these  
ports before you can use iChat.

Depending on the iChat functions you require, make sure the following ports  

are open.

Ports Description

1080 SOCKS5 protocol uses this port for 昀椀le transfers.

5060 iChat Session Initiation Protocol (SIP), required to 

use audio or video chat.

5190 iChat Instant Messenger.

This is the only port required for basic Instant 

Messenger use.

5222 TCP This port is used exclusively for TLS connections if 

an SSL certi昀椀cate is enabled. Otherwise, this port 
is used for nonencrypted connections.

5223 TCP This port is used for legacy SSL connections if an 

SSL certi昀椀cate is enabled.

5269 TCP This port is used for encrypted TLS 

server-to-server connections, as well as 

nonencrypted connections.

5678 iChat uses this local UDP to determine the user’s 

external IP address.

5297, 5298 Older versions of iChat use this port for BonJour 

IM. (Mac OS X v10.5 and later use dynamic ports.)

7777 The Jabber Proxy65 module uses this port for 

iChat Server 昀椀le transfer proxy.

16402 In Mac OS X 10.5 or later, this port can be used for 

SIP signaling.

16384–16403 Mac OS X 10.4 and earlier use these ports for 

audio or video chat. Audio and video packets are 

sent using RTP and RTCP, and tra昀케c is exchanged 
in .Mac (MobileMe) to determine the user’s 

external port information.

TLS encryption is preferred, because TLS connections are more secure than  

SSL connections.

If you run iChat server on a secure network behind a 昀椀rewall, you don’t need to 
con昀椀gure 昀椀rewall settings as long as communication between users is within the 
network. Firewall settings are required when communicating outside the 昀椀rewall.



For more information about the 昀椀rewall service and settings, see Network Services 

Administration.

Turning the iChat Service On
Before you can con昀椀gure iChat settings, you must turn the iChat service on in  
Server Admin.

To turn the iChat service on㨀̀

 1 Open Server Admin and connect to the server.

 2 Click Settings, then click Services.

 3 Select the iChat checkbox.

 4 Click Save.

From the command line㨀̀

To start the iChat service: m

$ sudo serveradmin start jabber

For information about serveradmin, see its man page. For the basics of command-line 

tool usage, see Introduction to Command-Line Administration.

Setting Up iChat
There are two groups of settings on the Settings pane for iChat in Server Admin:

 Â General — Use to set host domain, SSL certi昀椀cate, authentication method, and 
XMPP server-to-server federation for iChat.

 Â Logging — Use to con昀椀gure message log settings for iChat.

The following sections describe how to con昀椀gure these settings and how to start iChat 
when you 昀椀nish.

Con昀椀guring iChat General Settings
You use the General settings pane in iChat to add host domains, choose an SSL certi昀椀cate 
and authentication method, and con昀椀gure XMPP server-to-server federation settings.

To con昀椀gure iChat General settings:
 1 Open Server Admin and connect to the server.

 2 Click the triangle at the left of the server.

The list of services appears.

 3 From the expanded Servers list, select iChat.
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 4 Click Settings, then click General.

 5 Click the Add (+) button to add host domains.

The Host Domains list designates the domain names you want iChat to support. 

Initially, the server host name is shown. You can add or remove other names that 

resolve to the iChat server IP address such as aliases de昀椀ned in DNS. When starting 
iChat you must specify a DNS for the service. 

Host domains are used to construct Jabber IDs, which identify iChat users. An example 

of a Jabber ID is nancy@example1.apple.com.

 6 From the SSL Certi昀椀cate pop-up menu, choose an SSL certi昀椀cate.

The menu lists all SSL certi昀椀cates that are installed on the server.

To create or add certi昀椀cates, choose Manage Certi昀椀cates from the SSL Certi昀椀cate  
pop-up menu.

For more information about increasing server security, see Mac OS X Server Security 

Con昀椀guration. Information about creating and managing server certi昀椀cates can also be 
found in Advanced Server Administration.

 7 Choose the method of authentication from the Authentication pop-up menu.

Choose Standard if you want iChat to only accept password authentication. Â

Choose Kerberos if you want iChat to only accept Kerberos authentication. Â

Choose Any Method if you want iChat to accept password and Kerberos  Â

authentication.

 8 To permit iChat to communicate with other XMPP-compliant chat servers, select 

“Enable XMPP server-to-server federation.”

 9 If you use a certi昀椀cate with iChat, select “Require secure server-to-server federation.” 

This option requires an SSL certi昀椀cate to be installed, which is used to secure the 
server-to-server federation. For more information, see “Securing Server-to-Server 

Connections” on page 28.

 10 To permit unrestricted server-to-server communication, select “Allow federation with 

all domains.”

 11 To restrict server-to-server communication to servers that are listed, select “Allow 

federation with the following domains.”

You can add or remove domains using the Add (+) or Delete (–) buttons below the list.

For more information about server-to-server communication, see “Linking Multiple 

Chat Servers (S2S)” on page 27.

 12 Click Save.



From the command line㨀̀

To view service settings: m

$ sudo serveradmin settings jabber

The following is an example of the output:

jabber:savedChatsArchiveInterval = 7

jabber:enableAutoBuddy = yes

jabber:s2sAllowedDomains = _empty_array

jabber:requireSecureS2S = no

jabber:sslKeyFile = "/etc/certificates/Default.crtkey"

jabber:hosts:_array_index:0 = "pb4server"

jabber:s2sRestrictDomains = no

jabber:eventLogArchiveInterval = 7

jabber:savedChatsLocation = "/var/jabberd/message_archives"

jabber:enableXMPP = yes

jabber:enableSavedChats = no

jabber:welcomeMessage = "Welcome to the iChat Server at pb4server!"

jabber:logLevel = "ALL"

To set service settings: m

$ sudo serveradmin settings jabber:setting = value

Parameter Description

setting The name of the setting.

value The value of the setting.

For information about serveradmin, see its man page. For the basics of command-line 

tool usage, see Introduction to Command-Line Administration.

Con昀椀guring Logging Settings
Use Server Admin to con昀椀gure iChat to save chat messages in a location of your 
choice and to specify when to archive the message log.

To set up iChat to log chat sessions㨀̀

 1 Open Server Admin and connect to the server.

 2 Click the triangle at the left of the server.

The list of services appears.

 3 Click iChat and then click Settings.

 4 Click the Logging button.

 5 Select “Automatically save chat messages” to keep a record of user chat messages sent 

over network.
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 6 In the Location 昀椀eld, enter a location, or click Choose to browse to a folder where you 
want to save chat message logs.

You must have write access to the selected folder and any parent directories.

 7 Select “Archive saved messages every __ day(s)” and enter a number in the 昀椀eld to 
archive the saved chat message logs on a schedule.

The number is the interval of days between each archive.

Archiving saves disk space by compressing older message logs. The compressed 

message archives are saved inde昀椀nitely until removed by the administrator.

 8 Click Save.

Starting iChat
Use Server Admin to start iChat. After you start iChat, it restarts when the server restarts.

To start iChat㨀̀

 1 Open Server Admin and connect to the server.

 2 Click the triangle at the left of the server.

The list of services appears.

 3 In the expanded Servers list, click iChat.

 4 Click Start iChat (below the Servers list).

Managing iChat
In this section you learn about day-to-day tasks you perform after you set up iChat on 

your server. Initial setup information appears in “Setting Up iChat” on page 18.

Checking iChat Status
Use Server Admin to check the status of iChat.

To view iChat Status㨀̀

 1 Open Server Admin and connect to the server.

 2 Click the triangle at the left of the server.

The list of services appears.

 3 From the expanded Servers list, select iChat.

 4 To see information such as whether the service is running, when it started, the servers 

domain name, and the number of connections, click Overview.

 5 To review iChat Service, File Proxy, and Multiuser Conference logs, click Logs.

To choose which log to view, use the View pop-up menu.

Use the Filter 昀椀eld in the upper right to search for speci昀椀c entries.



Setting Access Control for iChat
You can control who can use iChat using Open Directory authentication and iChat 

service access settings. Keep in mind the following:

Only a user or group de昀椀ned in the Open Directory search path can use iChat.   Â

You can permit or restrict access to iChat by adding or removing users and groups 

to an Open Directory search path.

For more information about Open Directory and how to use Workgroup Manager 

to add users to the Open Directory, see Open Directory Administration and User 

Management.

SACLs enable you to specify who has access to iChat. This provides you with greater  Â

control over who can use the service and the administrators who have access to 

monitor and manage the service. iChat requires that authenticated users belong to 

the iChat SACL.

For information about setting iChat service access for users and groups, see “Setting 

iChat SACL Permissions for Users and Groups” on page 22.

For information about setting iChat service access for administrators, see “To get the 

most recent onscreen help for Mac OS X Server:” on page 6.

Users created in Workgroup Manager must be added to the iChat SACL (using  Â

Server Admin), before they can log into iChat.

Setting iChat SACL Permissions for Users and Groups
Use Server Admin to set SACL permissions for users and groups to access iChat.

To set user and group SACL permissions for iChat㨀̀

 1 Open Server Admin and connect to the server.

 2 Click Access.

 3 Click Services.

 4 Select the level of restriction you want for the services:

To restrict access to all services, select “For all services.” Â

To set access permissions for individual services, select “For selected services below”  Â

and select the services from the Service list.

 5 Select the level of restriction you want for users and groups:

To provide unrestricted access, click “Allow all users and groups.” Â

To restrict access to speci昀椀c users and groups, select “Allow only users and groups  Â

below,” click the Add (+) button to open the Users & Groups window, and then drag 

users and groups from the Users & Groups window to the list. If you don’t see a 

recently created user, click the Refresh button (below the Servers list).

 6 Click Save.
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Setting SACL Permissions for Administrators
Use Server Admin to set SACL permissions for administrators to monitor and  

manage iChat.

To set administrator SACL permissions for iChat㨀̀

 1 Open Server Admin and connect to the server.

 2 Click Access.

 3 Click Administrators.

 4 Select the level of restriction you want for the services:

To restrict access to all services, select “For all services.” Â

To set access permissions for individual services, select “For selected services below”  Â

and select the services from the Service list.

 5 Click the Add (+) button to open the Users & Groups window.

 6 Drag users and groups to the list from the Users & Groups window.

 7 Set the user’s permission:

To grant administrator access, choose Administer from the Permission pop-up menu  Â

next to the user name.

To grant monitoring access, choose Monitor from the Permission pop-up menu next  Â

to the user name. 

 8 Click Save.

Using SSL for iChat
You can maximize the privacy of chats by implementing SSL with iChat. SSL uses 

a digital certi昀椀cate to validate the identity of the server and to establish secure, 
encrypted data exchanges for client-to-server and server-to-server connections.

The digital certi昀椀cate can be a self-signed certi昀椀cate or a certi昀椀cate imported from 
a certi昀椀cate authority. For information about de昀椀ning, obtaining, and installing 
certi昀椀cates on your server, see Advanced Server Administration.

iChat uses SSL to encrypt chat messages that are sent over the network. However, if 

your iChat server is logging chat messages, the messages are stored on the server in 

an unencrypted format. These unencrypted chat messages can be easily viewed by 

your server administrator. For information about message logging, see “Con昀椀guring 
Logging Settings” on page 20.

To identify an SSL certi昀椀cate for use by iChat:
 1 Open Server Admin and connect to the server.

 2 Click the triangle at the left of the server.

The list of services appears.



 3 Click iChat, then click Settings.

 4 Click General.

 5 From the SSL Certi昀椀cate pop-up menu, choose the certi昀椀cate you want iChat to use.

The menu lists all SSL certi昀椀cates that are installed on the server. To create or add 
certi昀椀cates, choose Manage Certi昀椀cates from the SSL Certi昀椀cate pop-up menu.

For more information about creating and managing server certi昀椀cates, see Advanced 

Server Administration.

 6 Click Save.

Locating iChat Con昀椀guration Files
iChat con昀椀guration settings are stored in con昀椀guration 昀椀les that correspond to the 
main jabberd process and to each of its component processes.

The following is a list of iChat components and their corresponding con昀椀guration  
昀椀le location.

Component Location

jabberd (startup and watchdog script) /etc/jabberd/jabberd.cfg

router (inter-module message routing) /etc/jabberd/router.xml

resolver (domain resolution) /etc/jabberd/resolver.xml

sm (session manager) /etc/jabberd/sm.xml

C2S (client-to-server communications) /etc/jabberd/c2s.xml

S2S (server-to-server communications) /etc/jabberd/s2s.xml

These 昀椀les de昀椀ne settings for the Jabber server and XMPP features supported by Jabber. 

Viewing iChat Logs
You can view iChat logs using Server Admin. iChat logs are located in the following 

locations:

The iChat service log is located in /var/log/system.log. Â

The iChat 昀椀le proxy log is located in /private/var/jabberd/log/proxy65.log. Â

The iChat multiuser conference log is located in /var/jabberd/log/mu-conference.log. Â

To view iChat logs㨀̀

 1 Open Server Admin and connect to the server.

 2 Click the triangle at the left of the server.

The list of services appears.

 3 Click iChat.

 4 Click Logs and then choose a log from the View pop-up menu.
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Turning Auto-Buddy Support On
You can con昀椀gure iChat preferences so that when user accounts are added through 
Server Preferences they become buddies. When users are removed, they are deleted 

from the buddies list.

Auto-buddy support is only available if the server is installed using the standard 

con昀椀guration. Auto-buddy support is located in Server Preferences.

To enable auto-buddy support㨀̀

 1 Open the Server Preferences application.

 2 Click Groups.

 3 From the Groups list, select the group that will use auto-buddy.

 4 Click Services.

 5 Select the “iChat Auto buddy List” checkbox.

Stopping iChat
Use Server Admin to stop iChat.

To stop iChat㨀̀

 1 Open Server Admin and connect to the server.

 2 Click the triangle at the left of the server.

The list of services appears.

 3 In the expanded Servers list, click iChat.

 4 Click Stop iChat (below the Servers list).

 5 Click Stop Now.

From the command line㨀̀

To stop iChat service: m

$ sudo serveradmin stop jabber

For information about serveradmin, see its man page. For the basics of command-line 

tool usage, see Introduction to Command-Line Administration.



Supporting iChat Clients
This section discusses setting up iChat client settings. 

Chatting with Jabber Buddies
If a user has a valid Jabber ID and is registered with a Jabber server, the user can chat 

with others registered with that Jabber server.

To chat with Jabber buddies㨀̀

 1 Choose Window > Jabber.

 2 To invite a Jabber buddy to chat, double-click his or her buddy picture.

Specifying User Name and Password
iChat lets users communicate using MobileMe, AIM, Google Talk, and Jabber. The steps 

here explain how to set up an account or get a new one from MobileMe or AIM.

To specify a user’s name and password㨀̀

 1 Choose iChat > Preferences and then click Accounts.

 2 Click the Add (+) button and choose an account type from the Account Type menu.

 3 Enter the user name and password:

 Â MobileMe or Mac.com㨀̀ Enter the user’s full email address (for example, 

tclark3@me.com or tclark3@mac.com) and password. The password can’t be longer 

than 20 characters.

To set up a new MobileMe subscription, click “Get an iChat Account.”

 Â AIM (AOL Instant Messenger)㨀̀ Enter the user’s AIM screen name (for example, 

tclark3001) and password.

 Â Jabber㨀̀ Enter the user’s full Jabber ID (for example, tclark@jabber.org) and password.

If the Jabber service provider has a speci昀椀c server name and address or requires a 
speci昀椀c port, click the arrow next to Server Options and enter the information.

 Â Google Talk㨀̀ Enter the user’s Google Talk account name and password.

 4 Click Done.

Using a Jabber ID with iChat
If a user has a Jabber account set up, the user can use their Jabber ID with iChat.

To use a Jabber ID with iChat:
 1 Choose iChat > Preferences and then click Accounts.

 2 Click the Add (+) button.

 3 From the Account Type menu, choose Jabber Account.

 4 Enter the user’s account name and password for their Jabber account and click Done.
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Use this chapter to customize iChat to create advanced 
con昀椀gurations.

iChat provides the following advanced con昀椀guration options:

“ Â Linking Multiple Chat Servers (S2S)” on page 27

“ Â Securing Server-to-Server Connections” on page 28

“ Â Integrating with Directory Services” on page 30

“ Â Setting the iChat Authentication Method” on page 30

“ Â Using Certi昀椀cates to Secure Server-to-Server Communication” on page 29

“ Â Setting Up iChat on Virtually Hosted Domains” on page 31

Linking Multiple Chat Servers (S2S)
Use Server Admin to con昀椀gure an expanded set of options for server-to-server 
(S2S) communication. For more information, see “Setting Up Server-to-Server 

Communication” on page 27.

Ideally, any server can allow S2S communication, as long as the server is XMPP 

compliant, accessible to the Internet, and not behind a 昀椀rewall.

To learn more, see the following topics:

“ Â Setting Up Server-to-Server Communication” on page 27

“ Â Securing Server-to-Server Connections” on page 28

Setting Up Server-to-Server Communication
Use Server Admin to establish S2S communication. When the S2S federation is 

enabled, communication with most other XMPP-compliant chat servers is enabled, 

including the ability to federate with Google Talk.

To establish communication between servers on di昀昀erent networks, administrators 
must con昀椀gure domain name server (DNS), network address translation (NAT), and 
昀椀rewalls, as needed. For more information, see Network Services Administration.

3Setting Up Advanced iChat 
Server Con昀椀gurations



Using Server Admin, you can take advantage of additional options for securing S2S 

communications. These options include 昀椀ltering domains where servers are matched 
to a given list.

To enable or disable Server-to-Server communication㨀̀

 1 Open Server Admin and connect to the server.

 2 Click the triangle at the left of the server.

The list of services appears.

 3 From the expanded Servers list, select iChat.

 4 Click Settings, then click General.

 5 Select or deselect “Enable XMPP server-to-server federation.”

 6 Select the “Require secure server-to-server federation” checkbox.

This restricts S2S communication and allows only iChat to connect with servers that 

support encrypted connections through SSL/TLS. This means that only servers that 

support TLS are allowed to communicate with your iChat server.

This option requires a Secure Socket Layer (SSL) certi昀椀cate to be installed, which is 
used to secure the S2S federation. For more information, see “Securing Server-to-

Server Connections” on page 28.

 7 Specify which domains are included in the S2S federation:

Select “Allow federation with all domains” to permit unrestricted S2S  Â

communication.

Select “Allow federation with the following domains” to restrict S2S communication  Â

to listed servers. 

You can add or remove domains using the Add (+) or Delete (–) buttons below  

the list.

 8 Click Save.

Securing Server-to-Server Connections
Using Server Admin, you can use additional security options to secure server-to-server 

communications. These options include using SSL certi昀椀cates and 昀椀ltering domains 
where servers are matched to those on a given list.

To learn more, see the following topics:

“ Â Using Certi昀椀cates to Secure Server-to-Server Communication” on page 29

“ Â Creating an Approved Federation Domain List” on page 30

“ Â Integrating with Directory Services” on page 30

“ Â Setting the iChat Authentication Method” on page 30
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Using Certi昀椀cates to Secure Server-to-Server Communication
Using Server Admin, you can secure server-to-server communication with certi昀椀cates.

Mac OS X Server includes a preinstalled, default, self-signed certi昀椀cate or you can 
select your own certi昀椀cate. The selected certi昀椀cate is used for client-to-server 
communications on ports 5222 and 5223 and for server-to-server communications.

Jabber provides the following ports:

5222, which accepts TLS connections if an SSL certi昀椀cate is enabled Â

5223, which accepts legacy SSL connections if an SSL certi昀椀cate is enabled Â

SSL encrypts your chat message over the network between client-to-server and 

server-to-server connections. However, if your iChat server is logging chat messages, 

your messages are stored in an unencrypted format that can be easily viewed by your 

server administrator. For information about message logging, see “Step 5: Con昀椀gure 
iChat Logging settings” on page 16.

To select a certi昀椀cate:
 1 Open Server Admin and connect to the server.

 2 Click the triangle at the left of the server.

The list of services appears.

 3 From the expanded Servers list, select iChat.

 4 Click Settings, then click General.

 5 From the SSL Certi昀椀cate pop-up menu, choose an SSL certi昀椀cate.

The menu lists all SSL certi昀椀cates that are installed on the server.

To create or add certi昀椀cates, choose Manage Certi昀椀cates from the SSL Certi昀椀cate  
pop-up menu.

For more information about creating and managing server certi昀椀cates, see Advanced 

Server Administration.

 6 Click Save.



Creating an Approved Federation Domain List
Server Admin o昀昀ers the option of con昀椀guring an approved list of domains for S2S 
communication, where only host names and domains that are listed can communicate 

with your server. This is called a federation domain list.

To create a federation domain list㨀̀

 1 Open Server Admin and connect to the server.

 2 Click the triangle at the left of the server.

The list of services appears.

 3 From the expanded Servers list, select iChat.

 4 Click Settings, then click General.

 5 Select “Allow federation with the following domains” to restrict S2S communication to 

those servers listed. 

You can add or remove domains using the Add (+) or Delete (–) buttons below the list.

The entries can be complete host names or domains. (This can be a mix of servers  

and domains.) 

The server software does the rule-matching to see if these domains can interact. Any 

domain or host not in the approved list cannot communicate with your iChat server.

 6 Click Save.

Integrating with Directory Services
As with other services, iChat authentication is based on Open Directory or any other 

Lightweight Directory Access Protocol (LDAP) server bound to the iChat server.

iChat accesses user accounts through directory services and cannot directly access the 

LDAP server. You can also bind your server to other LDAP servers, enabling users on 

other LDAP servers to authenticate with your iChat server.

For more information, see Open Directory Administration.

Setting the iChat Authentication Method
iChat supports three methods of authentication: standard, Kerberos, or any. 

Kerberos authentication is the most secure. Administrators must use Server Admin 

to con昀椀gure an Open Directory master (with Kerberos enabled) to allow Kerberos 
authentication. Otherwise, the server can be con昀椀gured to use the Kerberos Domain 
Controller (KDC) on another host. However, the Kerberos realm hosted by the KDC 

must match the realm served by the iChat server.
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To select an authentication method㨀̀

 1 Open Server Admin and connect to the server.

 2 Click the triangle at the left of the server.

The list of services appears.

 3 From the expanded Servers list, select iChat.

 4 Click Settings, then click General.

 5 Choose the method of authentication from the Authentication pop-up menu:

Choose Standard if you want iChat to only accept password authentication. Â

Choose Kerberos if you want iChat to only accept Kerberos authentication. Â

Choose Any Method if you want iChat to accept password and Kerberos authentication. Â

 6 Click Save.

Setting Up iChat on Virtually Hosted Domains
iChat requires that your host have a host name to be used as the Jabber realm by the 

iChat server that is resolvable using DNS. This host name is used as the Jabber realm 

by the iChat server, and clients use this realm to connect to the service.

Clients use a Jabber Identi昀椀er (JID) to authenticate and interact with the server.  
The JID uses the format user@realm (for example, chatuser@chatserver.example.com). 

In this example, your iChat server would be con昀椀gured to host the realm 
chatserver.example.com.

DNS resolution directs clients to your server when they resolve that host name. 

To support multiple realms, DNS should be con昀椀gured appropriately. For more 
information, see Network Services Administration.

To con昀椀gure iChat on a virtually hosted domain:
 1 Open Server Admin and connect to the server.

 2 Click the triangle at the left of the server.

The list of services appears.

 3 From the expanded Servers list, select iChat.

 4 Click Settings, then click General.

 5 Change the realms served by iChat by adding a virtual domain to the Host Domains list.

You can add or remove domains using the Add (+) or Delete (–) buttons below the list.

Domains that are added are supported as Jabber realms.

 6 Click Save and restart iChat if necessary.
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